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Introduction to Photo Applications

Easy-PhotoPrint
Easy-PhotoPrint is a handy application program that allows you to make borderless (full page) prints 
from the images you recorded with your digital camera. You can make prints easily, just by selecting 
image data and paper size and type. 
Easy-PhotoPrint also has simple editing functions such as trimming and rotation of images.
Easy-PhotoPrint supports Exif Print (Exif 2.2). The image captured with an Exif Print-compliant 
digital camera can be optimized using data, such as camera settings (white balance, exposure time) 
etc, stored at the same time of shooting, yielding extremely high-quality prints.

ZoomBrowser EX
ZoomBrowser EX is an application program that displays the images (stored in the memory card) 
you recorded with your digital camera as thumbnails, allowing you to import the selected images 
into your computer and view, manage, and edit them. ZoomBrowser EX also allows you to process 
the image files already stored in the computer in the same manner. 
The image data selected with ZoomBrowser EX can be edited using another application program in 
a coordinated fashion.
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PhotoRecord
PhotoRecord allows you to make photo-quality prints from the image data you selected with 
ZoomBrowser EX. PhotoRecord can make an index print, print multiple images on a sheet of paper 
with them laid out automatically, or print images on Canon perforated paper. With PhotoRecord, you 
can add a frame, background, and/or letters to your photo. PhotoRecord also supports basic editing 
functions such as trimming, rotation, color adjustment.

PhotoStitch
PhotoStitch allows you to make a panoramic photo from the images you recorded with your digital 
camera. PhotoStitch can merge separate images into a panoramic image. With PhotoStitch, you 
can make a panoramic photo of a grand view spreading out 360-degrees around you. A desired 
number of images can be easily stitched vertically or horizontally, allowing you to take full advantage 
of digital photo printing (for example, you can make unique posters with ease). The Wide mode is 
useful when you want to create a wide panoramic photo of buildings and other straight-lined objects 
with straight lines as natural as the original.
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Printing with ZoomBrowser EX

ZoomBrowser EX enables you to import image data captured with digital cameras or scanners into 
a computer and produce photo-quality printouts in a quick and easy fashion. Using ZoomBrowser 
EX with a Canon BJ printer and a scanner or digital camera, you can enjoy superb-quality photo 
prints.
Custom Layout Printing 
(Artwork/Layout Album)

Printing a Photo Index 
(Index Printing)

You can arrange images in a desired layout and 
apply artwork including clipping, resizing, rotation, 
text insertion, and ornamentation with photo 
frames and background. 

You can print a photo index that contains 
thumbnails automatically arranged in a suitable 
layout for the selected thumbnail size (large, 
medium, or small). 
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Printing in a Specified Photo Size 
(Fixed Photo Size Printing)

Printing in the Borderless Printing Mode 
(Tiled Photo)

You can print images in the specified photo 
size.

You can print images with no margins around each 
image, so that a single image is printed borderless 
along the paper edges and multiple images are 
arranged like tiles with no space between them 
(available with BJ printers that support the 
borderless printing feature).
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Printing on Canon Perforated Paper

You can easily make your images fit on a 
sheet of Canon perforated paper such as 
<FM-101> or <PC-101S>.
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Basic Operation Procedure

The basic operation steps to capture, import, edit, and print photo images are summarized below.

STEP 1
Shooting / scanning

Acquire images with a digital camera or a scanner.
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STEP 2
Importing images

Start ZoomBrowser EX.

Using the Camera Window, import 
images from a memory card or a 
digital camera.

ZoomBrowser EX supports 
some simple image editing 
features.

The Automation wizard provides easy 
means of importing images.
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STEP 3
Selecting a layout

Specify the print mode. Just follow the wizard to select a print mode option 
from Artwork/Layout album, Index printing, Fixed photo size printing, 
Borderless printing (Tiled photo), and Canon perforated paper printing.
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STEP 4
Applying artwork

You can apply artwork 
including clipping, resizing, 
adding text, and 
ornamentation such as adding 
photo frames or background 
to the imported images.

STEP 5
Printing

The images can be printed on Canon 
perforated paper (such as Photo Paper 
Pro <PC-101S> or Glossy Photo Card 
<FM-101>). Borderless printing is also 
supported.
*Some features and paper sizes may not 
be supported depending on the models of 
printers.
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Using Canon Utilities

Canon Utilities are the application software included in the BJ Solution Disk or Setup Software & 
User’s Guide in the CD-ROM that comes with your BJ series printer. These utilities enable you to 
display, save (import) to the computer’s hard disk, edit, print the images captured using a digital 
camera or scanner. 
For the summary of each function, refer to Introduction to Photo Applications.

• Starting ZoomBrowser EX
• Creating Panoramic Photo Using PhotoStitch
• What is Easy-PhotoPrint?
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Starting ZoomBrowser EX

This section describes how to start ZoomBrowser EX.

ZoomBrowser EX supports the following image file types:

bmp Windows bitmap

crw RAW

fpx Flachpix

jpg Joint Photographic Experts Group (JPEG)

tif Tagged Image File Format (TIFF)

pcd KODAK Photo CD

wmf Windows Metafile
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Steps

1 Click Start and select Programs - Canon Utilities - ZoomBrowser EX - 
ZoomBrowser EX.

ZoomBrowser EX starts and ZoomBrowser EX application window opens.
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Note ➤ To learn more about the main window, refer to Basic Operations in the Browser 
Display Area.
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When starting ZoomBrowser EX for the First Time...
When starting ZoomBrowser EX for the first time, you will see a message window as shown below.

Click the Yes button to register the Windows folder named My Picture as an Image Folder of 
ZoomBrowser EX. This folder will become an image data storage folder and images imported from 
a digital camera or scanner can be stored in this folder. ZoomBrowser displays the thumbnails of the 
images stored in this folder in the Browser Display Area.
Click the No button, if you do not want to register the My Picture folder to the ZoomBrowser EX.
This message appears only when the ZoomBrowser EX is started for the first time.
For more detailed information on registering Image Folders, refer to Image Database.
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Creating Panoramic Photo Using PhotoStitch

PhotoStitch is an easy-to-use image merger utility which enables you to create a panoramic photo 
by merging multiple photos taken with a digital camera.

Steps

1 In the Browser Display Area of the ZoomBrowser EX, select multiple photo images 
(thumbnails) to merge.

2 Open the Edit menu and select the PhotoStitch command.

PhotoStitch starts and loads the selected photo images.

Merge as many images as you like either vertically or horizontally by a simple operation, and create 
posters and other photo-prints. Also try the wide-mode merging which shows buildings and other 
straight-lined objects with straight lines as natural as the original.
For more details on the merging procedure, refer to the Help of PhotoStitch.
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What is Easy-PhotoPrint?

Easy-PhotoPrint allows you to make borderless prints simply by selecting your digital camera 
images and the paper size and type. Easy-PhotoPrint is useful when you want to make prints 
quickly. Easy-PhotoPrint also has simple editing functions such as trimming and rotation of images. 
Easy-PhotoPrint supports Exif Print.

Note ➤ For details on the operation procedure, refer to Printing with Easy-PhotoPrint.
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Using ZoomBrowser EX

This chapter describes the basic operations and the functions of the ZoomBrowser EX.

• Basic Operations in the Browser Display Area
• Changing View Mode in the Browser Display Area
• Image Database
• Processing Image Using Image Viewer
• Slide Show
• Time Tunnel
• Adding Sound to Image
• Processing Image for Sending by E-mail
• Editing Image Using Other Image Processing Programs
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Basic Operations in the Browser Display Area

Part names and basic operations in the Browser Display Area are described in this section.
For more detailed information on working with ZoomBrowser EX, refer to the Help of ZoomBrowser 
EX.

Tree View
Displays all the Image Folders and their subfolders that are 
registered to ZoomBrowser EX.
When a Canon digital camera is connected to your com-
puter, double-click the Canon Camera icon, and you can 
view all the photos stored in the memory card of camera in 
the Camera Window.

Browser Display Area
Displays the contents of the Image Folder that is 
currently selected in the Tree View. Individual 
images are shown as thumbnails. You can change 
the thumbnail size, the way the information is dis-
played, the viewing modes, and other settings.

Thumbnails
Reduced images of the files contained in the folder that is currently 
selected in the Tree View. You can select images for processing by 
clicking the thumbnails.To select two or more images, click the thumb-
nails one by one while pressing the Ctrl key.

The information screen shows the number 
of subfolders and image files contained in 
the current folder.

Control Panel
Control buttons are provided 
here. Manage and process 
images shown in the 
Browser Display Area by 
clicking these buttons.
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MINIMIZE buttons
Click this button to reduce the Control Panel into a minia-
ture window (see the figure on the right). You can mouse-
drag it anywhere on the computer screen.

View Mode buttons
ZOOM MODE
Click the ZOOM MODE button on the Control Panel to enter the Zoom mode. The Zoom mode displays the 
images contained in the folder currently selected in the Tree View, in the reduced form of thumbnails. If the folder 
contains subfolders, the contents of the subfolders are also displayed, as thumbnails grouped under subfolder 
names.
SCROLL MODE
Click the SCROLL MODE button on the Control Panel to enter the Scroll mode. The Scroll mode displays the 
images and subfolders contained in the folder currently selected in the Tree View. The images are shown as 
thumbnails, while the subfolders are shown as folder icons.
When in the Scroll Mode, you can zoom in on a desired folder and view its contents, by double-clicking the folder. 

SHOW PROPERTIES button
Click this to view the information about the image 
currently selected in the Browser Display Area.

REFRESH button
Click this to refresh the display of selected images 
(thumbnails) or the contents of the selected folder.

IMPORT IMAGES button
Click this to import images from an input device 
(digital camera, memory card, etc.), currently con-
nected to the computer.

PRINT button
Click this to open the Print submenu in which you can 
select Layout or Index printing option. When Layout is 
selected, the PhotoRecord Print Modes window opens and 
the Print Modes wizard becomes ready to start.

VIEW IMAGE button
Click this to open the Image Viewer and view the selected image.

DELETE button
Click this to delete the images or folders currently selected in the Browser Display Area.
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Tool switching buttons
Click these buttons to select a tool (mouse pointer) used in the Browser Display Area. 
Button Name Function

SELECT
button

Turns the mouse pointer into a selection tool.Select this tool for the usual 
operations in ZoomBrowser EX, for example, selecting images and folders.

ZOOM IN
button

Turns the mouse pointer into a zoom-in tool.Select this tool for zooming in 
or (enlarging) the images (thumbnails) in the Browser Display Area.

ZOOM OUT
button

Turns the mouse pointer into a zoom-out tool.Select this tool for zooming 
out or (reducing) the images (thumbnails) in the Browser Display Area.
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Changing View Mode in the Browser Display Area

There are two View Mode buttons in the Control Panel, the SCROLL MODE button and the ZOOM 
MODE button.

� Zoom Mode
Click the ZOOM MODE button on the Control Panel to enter the Zoom mode. The images contained 
in the folder selected in the Tree View are displayed in the reduced form of thumbnails. If the folder 
contains subfolders, the contents of the subfolders are also displayed, as thumbnails grouped under 
subfolder names.

To zoom out the magnified images, click the button on the top-right corner of the Browser 
Display Area.

Double-click the 
subfolder background
to zoom in images.

Folder Subfolder 
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� Scroll Mode
Click the SCROLL MODE button on the Control Panel to enter the Scroll mode. The images in the 
selected folder or subfolders contained in the selected folder are displayed. The images are shown 
as thumbnails, while the subfolders are shown as folder icons.When in the Scroll Mode, you can 
zoom in the images contained a subfolder by double-clicking the folder icon. This enlarges the view 
of the folder contents until it fills the Browser Display Area.
 

Double-click the 
folder icon to zoom 
in the images con-
tained in the sub-
folder.
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Using Magnifier glass

Some thumbnails are displayed smaller than others, depending on the folder structure. The 
Magnifier is a convenient tool for viewing small thumbnails.
To use the Magnifier, select the Magnifier from the View menu.
You can move the Magnifier glass over the Browser Display Area by dragging it with the mouse. 
When you want to have a closer look, point the glass to a thumbnail, and view the enlarged image in 
the Magnifier window.

To return to the normal view, close the Magnifier window, by clicking the Close button on the top 
right corner of the MAGNIFIER window.

MAGNIFIER window Use the slide control to increase or decrease the magnification.

Magnifier glass
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Image Database

Registering Image Folders is a necessary procedure, if you have image data stored in your hard 
disk folders or on removable volumes, and if you want to process, print or manage them from 
ZoomBrowser EX. First register the folder/volume which you want to store the image data.
When a folder on the hard disk is registered as an Image Folder, you can save folders and images 
in that Folder from the ZoomBrowser EX window. Image data imported from a memory card of 
digital camera or other input devices will be saved as image files in those registered Image Folders.
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Image Library One

When ZoomBrowser EX is installed in your computer, it automatically creates a default folder 
named Image Library One, where it copies its sample image files.
Under this default Folder, you can create a new folder and save the imported images. You can also 
create a new Image Folder besides the default one.

Folders that comprises the default Image Folder
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Registering the My Pictures folder as an Image Folder
On starting ZoomBrowser EX for the first time, a message box appears and asks you if you want to 
register the My Pictures folder to the ZoomBrowser EX. If you click Yes here, the Windows folder 
named My Pictures will be registered as an Image Folder and displayed in the Tree View.

The registered Image Folder
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Registering Folders on the Hard Disk as Image Folders

You can select folders on your hard disks and register them as new Image Folders.
To learn how to register removable volumes such as CDs, MOs and FDs, refer to Registering 
Removable Volumes as Image Folders.

Steps

1 Start ZoomBrowser EX.
To learn how to start ZoomBrowser EX, refer to Starting ZoomBrowser EX.

2 Click the REGISTER IMAGE FOLDER button.
The Register Image Folder dialog box appears.
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3 From the Register Image Folder dialog box, select the folder which you want to 
register as an Image Folder, and click the OK button.
The registration message box appears.

4 Click the OK button.
The selected folder will be registered as an Image Folder.

Note ➤ If the selected folder contains any subfolders or image files, the ZoomBrowser EX 
database will automatically register those subfolders and image files. 
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Registering Removable Volumes as Image Folders

You can register removable volumes such as CDs, MOs and FDs, as new Image Folders.
When a volume is registered as an Image Folder, the database acquires its file information, 
including the thumbnails, file names and dates of the creation of image data. This enables you to 
view and check the contents of the registered volume from the computer screen, even if the volume 
itself is not loaded.

To learn how to register folders that are on your hard disks, refer to Registering Folders on the Hard 
Disk as Image Folders.

Steps

1 Load the removable volume which you want to register into the media drive.
Be sure to load it before starting ZoomBrowser EX.

2 Start ZoomBrowser EX.
To know how to start ZoomBrowser EX, refer to Starting ZoomBrowser EX.
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3 Click the REGISTER IMAGE FOLDER button.
The Register Image Folder dialog box appears.

4 Select the removable drive, and click the OK button.
The registration message box appears.

5 Click the OK button.
The Set Logical Volume Name dialog box appears.
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6 Type in a name for the current volume, and click the OK button.
This registers the volume as an Image Folder. The database acquires information 
about all the folders and image files contained in that particular volume.

Note ➤ If the selected volume has already been given a volume label, the dialog box 
displays that volume label as the default name. You can change it if you like, since 
a removable volume name is not the same thing as a volume label.

Note ➤ When working with images in a registered removable volume, for example, viewing 
them in the Image Viewer, or processing or printing them, you need the volume 
actually loaded onto the media drive. If you select an image and try to execute one 
of these operations without loading the volume, a message window prompts you to 
load it, as shown below.

The removable volume will be registered as an Image Folder 
named “IMAGELIB.”

Insert the volume and click the Retry button to load 
the image to the ZoomBrowser EX.
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Creating New Folders

You can create a new folder within a registered Image Folder or its subfolder.

Steps

1 On the Tree View, select and right-click with the mouse an Image Folder or a 
subfolder within which you want to create a new folder.
The pop-up menu opens.

2 Select the New Folder from the menu.
The New Folder dialog box opens.

The selected Image Folder or subfolder is 
displayed here. You can change the location of 
the new folder to create by specifying a desired 
folder from the Create new folder in drop-
down list.
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3 Type in the name for a new folder.

4 Click the OK button.
The new folder will be created under the selected Image Folder or subfolder.

The new folder “Digital Camera” is 
created.
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Changing Location of Image Files

You can move image files to a new location, by drag-and-dropping the thumbnails from the Browser 
Display Area onto any folder displayed in the Tree View.

You can also move a whole folder by drag-and-dropping the folder icon to a new location in the Tree 
View.
To copy an image or folder to a new location, drag-and-drop it while pressing the Ctrl key.

Copy images to 
another folder by drag-
and-dropping the 
thumbnails while 
pressing the Ctrl key.

Move an image to a new 
location by drag-and-drop-
ping the thumbnail onto 
the destination folder.
If you want to move multi-
ple images, select thumb-
nails while pressing the 
Ctrl key, then drag-and-
drop the thumbnails onto 
the destination folder.
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Deleting Images

When an image(s) is displayed and selected in the Browser Display Area, you can delete the image 
file(s) by clicking the DELETE button.

Note ➤ When the Delete button is clicked, the actual image file(s) is completely deleted 
from your computer's hard disk or the removable volume.

1. Select an image (thumbnail) you want to 
delete.

2. Click the DELETE button to open the Delete 
dialog box.

3. Click the Delete button.
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You can also delete a folder from your computer, by selecting the folder icon in the Tree View and 
then clicking the DELETE button.

Note ➤ When the Delete button is clicked, the folder is completely deleted from your 
computer's hard disk or the removable volume, not only the Image Folder (that is, 
the actual folder registered as an Image Folder) but also all its subfolders.

1. In the Tree View, select the Image 
Folder or the subfolder you want to 
delete.

2. Click the DELETE button to open the 
Delete dialog box.

3. Click the Delete button to delete the 
selected Image Folder or the subfolder.
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Managing Image Folders Using Shortcut Menu

Select a folder or an Image Folder in the Tree View, and right-click with the mouse. This displays a 
pop-up menu which offers you the option commands as listed in the table below.

Command Brief explanation of its function

New Folder Creates a new folder under the Image Folder or subfolder selected in the Tree View.

Refer to Creating New Folders for more details.

Rename Folder Allows you to rename the selected Image Folder or subfolder. Note that this command 
is not for renaming a removable volume registered as an Image Folder. 

Deregister Image Folder Deregisters the selected Image Folder. This command does not delete any actual 
image files or subfolders contained in the deregistered Image Folder. It only deletes 
information on the folder registered to the ZoomBrowser EX.

Set Logical Volume 
Name

Becomes selectable only when you have selected a removable volume which is regis-
tered as an Image Folder. Allows you to rename the selected volume. 

Set Folder Color You can change the color of both the folder icon and the background in the Browser 
Display Area.

Remove Folder Color Becomes selectable only when you have selected a folder whose folder color has 
been changed. Clears the current color settings and restores the default color.

Refresh Folder Refresh the contents information (database) of the selected Image Folder or subfolder.

This command is also executed using the REFRESH button. Refer to Refreshing View 
in the Browser Display Area for more details.
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Delete Deletes the selected Image Folder or subfolder. Care must be taken for this command 
execution. Once the Delete command is executed, the actual image files and subfold-
ers are completely erased from your computer's hard disk. 

This command is also executed using the DELETE button. Refer to Deleting Images 
for more details.

Copy Copies the selected Image Folder or subfolder including its all image files and subfold-
ers.

Paste Pastes the copied Image Folder or subfolder under the selected folder in the Tree 
View.

Properties Becomes selectable only when an Image Folder is selected. Allows you to view the 
properties of the folder or the removable volume registered as an Image Folder.
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Refreshing View in the Browser Display Area

If you perform file management using other file management software such as Windows Explorer, 
the ZoomBrowser EX may not always reflect the updates done with other file management software 
immediately.
To reflect the updates on the database, select  the Image Folder or subfolder which you want to 
update in the Tree View, and then click the REFRESH button.

Another way to refresh the ZoomBrowser EX database is to use the commands provided in the 
View menu.

Command Information to be updated

 Refresh Current Folder Contents of the folder currently displayed in the Browser 
Display Area.

Refresh Online Registered Folders Data on the whole database of ZoomBrowser EX.

REFRESH button
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Processing Image Using Image Viewer

You can view the actual image of the selected thumbnail by opening the Image Viewer. First select 
the desired image and then click the VIEW IMAGE button.

Double-clicking the selected thumbnail in the Browser Display 
Area also opens the Image Viewer window.
In this window, you can crop and/or adjust colors of the image, and 
save the result as a new file.

Image size, date and 
time it was taken are 
displayed here.

VIEW IMAGE button
Click this to open the 
Image Viewer

The zoom ratio is displayed here. 
Specify the desired ratio.
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Cropping Image

Select the portion of the image you want to keep by mouse-dragging over it, and then click the 
CROP button. Areas outside the selection will be trimmed away.

Cropped area

CROP button
Click this to crop along the 
trimming line.
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Adjusting Image Colors

The color adjustment slider controls allow you to adjust color, brightness and contrast by dragging 
them to and fro.

See how color, brightness and 
contrast have been adjusted.

Color adjustment slider controls
Drag them to and fro, to change 
color, brightness and contrast.
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Saving Image after Processing

The processed image can be saved as a new file.

Type in the file name and specify 
the file type, then click the Save 
button. The image is saved as a 
new file.

SAVE AS button
Click this to open the Save As 
dialog box.
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Slide Show

This function enables you to display the images selected in the Browser Display Area as an 
automated slide show. You can view them in sequence using the entire computer screen.

Steps

1 Select the Slide Show Options from the View menu.
The Slide Show Options dialog box opens to allow you to specify a set of 
parameters.

2 Specify how you want to have the images displayed.
You can choose the playing mode and apply enhancing effects to the slide show.
When the After a time delay option is selected, move the slide control to specify 
the interval after which the show should move on to the next picture.
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3 Specify how you want to play slide show sequentially using the Loop options.

Clicking the  sets the sequential image display through to the last image. The 
slide show ends and closes after the last image shown. 
Clicking the  sets the endless sequential image display. 
To exit from this endless loop, you will have to press the Esc key or Close Slide 
Show button to end and close the slide show.
For details on how to set the parameters, click the Help button in the Slide Show 
Options dialog box.

4 Click the OK button.
The Slide Show Options dialog box closes and opens the Browser Display Area 
again.

5 Select the images or folders you want to display in the slide show in the Browser 
Display Area.
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6 Select the Slide Show from the View menu.
The slide show starts and selected images are displayed in sequence on  the entire 
computer screen according to the parameters set in the Slide Show Options 
dialog box.
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Slide Show Control Buttons
While the slide show is in progress, the control buttons are displayed on the bottom-right corner of 
the screen.

When the No Info radio button is selected in the Slide Show Options dialog box, no control buttons 
are shown on the screen. If this is the case, right-click to open a pop-up menu as shown below.
Select the corresponding option from this menu.

Pause/Replay button
Click the Pause button to stop the automated slide 
show temporarily.
Pausing the show will turn this into the 

Replay button.

Previous Image button
Displays the previous 
image again.

Next Image button
Advances the show to the next image.

Close Slide Show button
Click this to exit the slide 
show.

Print button
Click this to mark the current image for printing, while a slide show is in 
progress. When the show is over, PhotoRecord will automatically start and 
layout the selected images for printing.
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Time Tunnel

You can open the Time Tunnel window by selecting the Time Tunnel... from the View menu.
When the Time Tunnel window opens, you see a series of rings which remind you of a time tunnel. 
The images in the Browser Display Area, or those contained in the selected folder, will be displayed 
in the Time Tunnel, positioned along the lines of the rings automatically. The thumbnails are arrayed 
in a sequential order by the date they were shot (file dates). Zoom in or out freely on the rings to 
change the arrangement, by moving the slide control or by specifying the date. Choose the display 
mode from among Rings, Spiral and Film by simply clicking the switch buttons. You can open the 
actual image of the desired thumbnail by double-clicking on it.

The Time Tunnel offers a variety of option features, including changing the display mode and 
searching through images by file date.
For details on how to set the parameters, click the Help button in the Time Tunnel window.

Note ➤ The Time Tunnel can handle up to 500 images.

Drag the slide control to zoom in and out 
on the Time Tunnel.

Rings, Spiral, Display Style settings, Speed 
Settings, Date/Time Display Color Settings, 
Open, Help and Exit buttons
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Adding Sound to Image

You can associate sound with an image by using the sound feature of ZoomBrowser EX.

Steps for Recording

1 Select the image to which you want to add sound in the Browser Display Area. 
Open the Properties menu and select the Add/Remove Sound.
The Sound dialog box appears.

2 Click the Add button.
The Open dialog box appears.
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3 Specify the sound file.
Selectable sound files are those in the WAV and the MIDI formats.

4 Click the Open button.
The name of the selected file appears in the Sound dialog box.

Click the Remove button here if you want to remove the sound file.
Click the Play button here if you want to play the sound file.

5 Click the OK button.
ZoomBrowser EX takes in the sound data.
When the sound is added, the image thumbnail is marked with a sound symbol on 
the top-right corner.
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Steps for Playing

1 Select an image thumbnail which has a Sound symbol on the top-right corner.

2 Open the Properties menu, and select the Play Sound command.
The Play Sound message box appears and starts playing the sound file.

When it has finished playing, the message box closes. Click the Cancel button to 
stop playing.



Processing Image for Sending by E-mail 55

Processing Image for Sending by E-mail

It is simple and easy for you to process images and attach them to an E-mail, if you use 
ZoomBrowser EX. Select the images in the Browser Display Area and follow the instructions of the 
wizard.

1 Select the image or images that you want to send in the Browser Display Area, and 
then select the Send Image(s) by E-mail from the Internet menu.
The wizard starts and the Select Compression dialog box opens.
If you select the Send image(s) without compression option here, the file will be 
attached in its original size.

2 Click the Next button.

The wizard goes on to the next step.
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3 Specify the resizing ratio and the image quality, and then click the Compress 
button.

The program starts compressing the image files.

The total file size after compression will be calculated and displayed in the bottom 
area of the dialog box.
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4 Click the Next button.
The wizard goes on to the next step.
To check how the resized images look on the screen, click the Preview button.

5 Choose what you want to do with the compressed image files, and then click the 
Finish button.
This closes the wizard and automatically creates an image file for sending with an 
E-mail.
If the Start e-mail program option is selected as the next step in 5. above, your E-
mail application will automatically start when the compression is completed, 
allowing you to edit an E-mail message. The images processed by ZoomBrowser 
EX will be automatically attached to the E-mail.
If the Save images in a folder option is selected as the next step in 5. above, the 
Select Directory dialog box will be displayed. Specify the destination folder to save 
the image files and save them as new files.

 
 For details of the operation, click the Help button in the E-mail wizard dialog box.
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Editing Image Using Other Image Processing Programs

ZoomBrowser EX allows you to do more image processing through cooperation with other image 
processing programs.

Opening Image Files using Other Image Processing Programs
You can specify your favorite image processing program for editing image files while using 
ZoomBrowser EX. When necessary, the image editing program opens automatically and imports 
the images that are selected in the Browser Display Area.

Specifying the Image Editing Program
Open the File menu, and select Preferences to open the Preferences dialog box. Select the 
Image Editor tab.
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When you select the Edit images using the default editor below: option, open the drop-down list 
and select the desired image editing program to be used as default.
When you select the Edit images using the program below: option, click the Browse button to 
display the Open dialog box, and specify the desired image editing program.
Click the OK button after selecting the desired image editing program.
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Importing Images

This chapter describes the functionality of ZoomBrowser EX to import/download images from your 
digital camera.

• Importing Images with the Automation Wizard
• Setting the Automation Wizard to Download Images
• Importing Images Using the Camera Window
• Importing Images from a TWAIN Device
• Importing Images by Drag-and-Drop Operation
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Importing Images with the Automation Wizard

The Automation Wizard enables you to save a sequence of actions from importing images into your 
computer through printing, so that ZoomBrowser EX will automatically repeat the same action 
sequence by a simple operation next time. 

The Automaiton Wizard starts when you connect a Canon digital camera to your computer or insert 
a memory card (Compact Flush card) into the memory card slot of a BJ printer connected to your 
computer after starting ZoomBrowser EX.

The Automation Wizard also starts when you connect a non-Canon digital camera or a memory 
card reader to your computer after starting ZoomBrowser EX.
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Selecting Automatic Image Downloading

When the Automation Wizard starts for the first time, the ZoomBrowser Automation Wizard dialog 
box appears as shown below:

Note ➤ If it is not the first time that the Automation Wizard starts, the ZoomBrowser 
Automation dialog box appears, ready to start automatic image downloading 
directly. Refer to When the ZoomBrowser Automation dialog box appears for 
details.
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Select the automated action which you want ZoomBrowser to perform first when it detects a 
connected device such as a digital camera or memory card.
The option items and their actions are as follows:

Option Action Further operation

Display images in 
the Camera Window

When you click the Finish button to 
quit the Automation Wizard, the 
Camera Window appears to display all 
the images stored in the digital camera 
(or memory card).

See Importing Images Using the 
Camera Window for the rest of the 
procedure.

Download images to 
ZoomBrowser EX

The Automation Wizard proceeds to 
download images. Click the Browse 
button to select the folder where to 
download the images. Automation 
Wizard copies and saves the image 
data to the folder specified here.

See Setting the Automation Wizard to 
Download Images.



Importing Images with the Automation Wizard 64

� When the ZoomBrowser Automation dialog box appears
When the ZoomBrowser Automation dialog box appears instead of the ZoomBrowser 
Automation Wizard dialog box, just click the Start button to repeat the same action sequence you 
have used to import images last time.

If you want to change the action sequence, click the Modify Settings button to open the 
ZoomBrowser Automation Wizard dialog box and reselect the desired actions.
Click the Cancel button to quit the Automation Wizard and return to the Browser Display Area window.
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Setting the Automation Wizard to Download Images

You can download images from the connected device by setting options in the ZoomBrowser 
Automation Wizard dialog box. The Automation Wizard saves your settings so that it will 
automatically trace the same action sequence when downloading images next time. 

Steps

1 Select the Download images to ZoomBrowser EX option in the ZoomBrowser 
Automation Wizard dialog box.

2 Click the Browse button to display a dialog box where you can specify a 
destination folder to copy the downloaded image data.
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3 Specify the folder and click the Next button.
The Automation Wizard proceeds to the next screen.
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4 Select a category of images to download.
The image category options are listed below:

Note ➤ For details on the images marked for printing or transfer, refer to the documentation 
that comes with your digital camera.

5 Click the Finish button.
ZoomBrowser EX starts downloading the images to the computer.
When image downloading is complete, the following message appears:

Option Action

Download all images Downloads all the images stored in the connected 
digital camera or memory card.

Download new images Downloads all the images except those already 
imported to the ZoomBrowser EX.

Download images marked for 
printing

Downloads the images marked for printing.

Download images marked for 
transfer

Downloads the images marked for transfer.
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6 Select a radio button to specify the next action to do on the downloaded image 
data.
The options are described below:

7 Click the OK button.
The Automation Wizard closes and the selected action starts automatically.
If you click the Cancel button, the Automation Wizard closes and ZoomBrowser EX 
returns to the Browser Display Area window without performing any action.
When the Automation Wizard closes, it saves the selected settings so that it can 
trace the same action sequence in the next session.

Option Action

Display Slide Show Displays all the downloaded images in a slide show.

Layout and Print Images Selects all the downloaded images and perform 
custom layout printing.

Print Index Selects all the imported images and perform index 
printing.

Send by E-mail Processes all the downloaded images so that you 
can attach them to E-mails and save them in the 
specified image folder for E-mail.
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Importing Images Using the Camera Window

Using the Camera Window, you can browse through all the images stored in the device connected 
to your computer, so that you can select, import, and save desired images in your computer. 

Steps

1 Open the Camera Window.
You can open the Camera Window by any one of the following operations:

Operation Data displayed in the Camera Window

(1) Select From D:\Dcim from
the IMPORT IMAGES but-
ton submenu.

All the images stored in the Dcim folders in the target drive
*The IMPORT IMAGES button submenu and the Tree View
show From D:\Dcim, From E:\PWSHOTO, etc. depend-
ing on data format of the memory card and the drive name
of the connected device.

*It is required that your computer have the hardware (mem-
ory card reader or PC card adapter for memory cards, etc.)
set up correctly, before importing the image data stored in
a memory card.

(2) Double-click From D:\Dcim
in the Tree View.

(3) Select From Canon Cam-
era from the IMPORT
IMAGES button submenu.

All the images stored in the Canon digital camera con-
nected to your computer

*Ensure that the digital camera driver is installed correctly.
Note that this function is not supported by some of the
Canon digital camera products.(4) Click the Canon Camera

icon in the Tree View.
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Note ➤ For more information on the Camera Window, refer to Basic Operation in the 
Camera Window.

(5) Select the Display Images
in the Camera Window
option from the Zoom-
Browser Automation Wiz-
ard dialog box.

All the images stored in the digital camera, memory card, or
any other device specified by the Automation Wizard

The Camera Window displays the thumbnails of images stored in the selected device.

(4)
(2)

(5)

(3)
(1)
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2 From the Tree View, select the target folder where you want to save the image files.

Note ➤ To know how to manage folders and libraries, refer to Image Database.

3 Return to the Camera Window. Click to select photos or images you want to import 
to your computer.
When you select a thumbnail, the area around the selected thumbnail changes its 
color.

The Camera Window displays 
the thumbnails of images 
contained in the selected 
device.

DOWNLOAD button
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4 Click the DOWNLOAD button in the Camera Window.
The selected images are saved as files in the computer. The downloaded images 
are displayed in the Browser Display Area.

5 Click the Close button at the upper-right corner of the Camera Window if you want 
to close the Camera Window now and disconnect the device.
If you want to continue downloading more photos or images, repeat Steps 3 and 4.
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Basic Operation in the Camera Window

The Camera Window shows thumbnails of the photos or images contained in the device connected 
to your computer, so you can browse through all the images in the device. 
This subsection describes how to use the control buttons in the Camera Window.
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Elements in the Camera Window
The Camera Window shows thumbnails of all the images stored in the device connected to your 
computer. Each thumbnail is associated with the image file information.
The Camera Window also provides options that enable you to import and print the images.
To select an image, click its thumbnail. Blue borders mark the selected image. To select two or more 
files, click the images one by one while pressing the Ctrl key.

Thumbnails
Photos or images stored in the connected device are displayed as thumbnails here. When an 
image is selected, its background turns blue.

(6) PRINT

(5) DOWNLOAD
(4) DELETE

(3) SELECT
(2) CONNECT CAMERA
(1) SETUP OPTIONS

(7) ROTATE

(8) UPLOAD

(9) IMAGE INFO
(10) SLIDE/DPOF
(11) HELP
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Note ➤ If photos were shot in the Stitch Assist mode of Canon digital camera, they are 
displayed with special marks and icons. Click the mark to start the PhotoStitch 
utility and merge photos to create a panoramic image.

Device image
When ZoomBrowser EX detects 
a connected device, the Camera 
Window shows an image to 
indicate the device type.

Memory card or non-Canon 
digital camera

Canon digital camera
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(1) SETUP OPTIONS
Click the SETUP OPTIONS button to display a setting menu containing the following options.

Note ➤ These setup options are available only when the connected digital camera is a 
Canon product. The dialog box offers somewhat different parameters depending on 
the product type.

(2) CONNECT CAMERA
Click the CONNECT CAMERA button to restart the connection process. All the thumbnails are 
reloaded from the camera into the computer.

Note ➤ The CONNECT CAMERA function is available only when the connected digital 
camera is a Canon product.

Menu option Function

Camera Settings Displays a dialog box that allows you to confirm or change date, owner 
information, and other settings for the connected camera.

Communication Settings Displays a dialog box that allows you to change the settings for the 
communication port to which the camera is connected.

My Camera Displays a dialog box that allows you to change the My Camera settings 
(only when a camera that supports the My Camera function is connected). 
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(3) SELECT
Click the SELECT button to display the selection menu as shown below:

Selects all the images currently displayed in the Camera 
Window.

Selects all the images in the Camera Window except 
those already imported. The mark 
in the top left corner of a thumbnail, 
as shown in the figure, indicates 
that the image has already been 
imported. 

Selects all the images marked for printing in the Camera 
Window.

Deselects all the images in the Camera Window.
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(4) DELETE
Use the DELETE button to clear the selected images completely from the device. If you select an 
image or images and click the DELETE button, a message appears as shown below:

Click Yes if you want to clear the images completely from the device. If you do not want to clear 
them, click No. The deleted images cannot be restored.

(5) DOWNLOAD
Use the DOWNLOAD button to copy images from the connected device to the specified folder in the 
Tree View of ZoomBrowser EX.
Select the images to download, and then click the DOWNLOAD button. Downloading starts and a 
monitor window appears, so that you can check the progress of downloading.

When copying is finished, the monitor window closes. If you want to cancel downloading while in 
progress, click the Cancel button in the monitor window.

The  icon that appears at one corner of a thumbnail indicates that the corresponding image 
has already been imported to your computer.
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(6) PRINT
Use the PRINT button to print images by activating the PhotoRecord utility. First select the images 
to print, and then click the PRINT button and select either Easy-PhotoPrint, Layout or Index from 
the PRINT button pop-up submenu.
Selecting Easy-PhotoPrint starts Easy-PhotoPrint.  By following a simple operation procedure, you 
can make a borderless (full page) print easily.
Select Layout to activate PhotoRecord. The selected photos are loaded automatically.
Select Index to display the Index Print Settings dialog box.

Note ➤ For details on the printing procedure, refer to Printing from PhotoRecord.

(7) ROTATE
Use the ROTATE button to rotate a thumbnail. A thumbnail is a reduced image of the actual file. 
First select the thumbnail to rotate, and then click the ROTATE button. A menu opens as shown 
below:

Rotating a thumbnail does not affect the actual image data, although the image is automatically 
rotated when it is copied to your computer.

Rotates the selected thumbnail 90 degrees anticlockwise.

Rotates the selected thumbnail 90 degrees clockwise.

Rotates the selected thumbnail 180 degrees.
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(8) UPLOAD
Use the UPLOAD button to copy images from your computer to the connected device. Click the 
UPLOAD button to open a dialog box and select the images to copy to the device. When an image 
or images are selected, the Save to Camera dialog box appears as shown below:

Another way of copying images to the connected device is to mouse-drag the images in the Browser 
Display Area and drop them onto the thumbnail area.

Specify the image size, select the resize option, and click the 
Save to Camera button. This starts copying the selected 
images to the connected device.
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(9) IMAGE INFO
Use the IMAGE INFO button to view the date of shot, the EV compensation, and other information 
concerning a photo.
First select a photo image, and click the IMAGE INFO button. The Camera Properties for Image 
window opens as shown below:

Note ➤ You can use this function only when the connected digital camera is a Canon 
product.
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(10) SLIDE/DPOF button
Click the SLIDE/DPOF button to display the Edit Slide/DPOF window.

You can use this dialog box to edit the camera's slide shows or its DPOF print settings, and write 
them onto the camera’s memory.

Note ➤ You can use this function only when the connected digital camera is a Canon 
product.
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(11) HELP
Click the HELP button to display the About Camera Window or the Help for the Camera Window.

About Camera Window that 
shows product information of 
the Camera Window
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Importing Images from a TWAIN Device

TWAIN is a standardized protocol for transferring image data between a digital camera, scanner or 
other digital image device and a computer.
This section describes how to import images from a TWAIN-compliant device to your computer.

Steps

Note ➤ • Ensure that the digital camera or scanner is connected properly.
• Ensure that the TWAIN driver is already installed in your computer.

1 Start ZoomBrowser EX.
Refer to Starting ZoomBrowser EX for the procedure to start ZoomBrowser EX.

2 Click the IMPORT IMAGES button to open a pop-up submenu. Select Select 
Source from the menu.

The Select Source dialog box appears.

3 Open the list box under Select a data source, select the connected TWAIN device, 
and then click the OK button.
The ZoomBrowser EX main window opens.
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4 From the Tree View, select the folder where you want to save the imported image files.
Ensure that the contents of the selected folder are displayed in the Browser Display 
Area.

5 Click the IMPORT IMAGES button, and then select the connected TWAIN device 
from the IMPORT IMAGES pop-up submenu.

The TWAIN driver window for the selected TWAIN device opens.

6 Follow the instructions in the TWAIN driver window to import images from the 
device.

7 Close the TWAIN driver window to return to the ZoomBrowser EX.
The imported images are saved in the folder currently displayed in the Browser 
Display Area.

Note ➤ If you use the procedure herein to import images from a Canon digital camera that 
supports ZoomBrowser EX, image file information such as the date of shooting and 
situation of shot is not saved in the ZoomBrowser EX’s database. Use the 
procedure in Importing Images Using the Camera Window if you want to import 
images with such information. 

The TWAIN device selected in Step 4 is 
added as an image source option to the 
IMPORT IMAGES pop-up submenu.
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Importing Images by Drag-and-Drop Operation

You can import images from a variety of storage media by simply drag-and-dropping the file icons 
onto the Browser Display Area. The files are registered in the library or folder currently displayed in 
the ZoomBrowser EX window. Use this easy method of registering image files from your hard disks, 
CDs, and MOs, without invoking the Register Image Folder function.

You can also drag-and-drop the icons onto the target library/folder displayed in the Tree View. Then 
the files will be registered in the ZoomBrowser EX database.
Note that when the files are stored in your hard disk (drive C), the drag-and-drop operation moves 
the actual files into the database. If you want to register them by copying, not moving the actual 
data, drag-and-drop the icons while pressing the Ctrl key.

Note ➤ To know what file types are supported by the database, refer to Starting 
ZoomBrowser EX.

Drop onto the Tree View Drop onto the Browser Display 
Area
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� Importing Images by Using the Windows Explorer
The libraries and folders registered in ZoomBrowser EX exist in your computer disks as actual 
folders. It means that you can register new images by using the Windows Explorer. Register new 
image files and folders in ZoomBrowser EX by copying them to the folders that are already 
registered.

Note ➤ For more information on libraries and registered folders of ZoomBrowser EX, refer 
to the Image Database.

1 Activate the Windows Explorer. Select the desired item and copy/move it to a 
medium or a folder that is already registered as a library or folder of ZoomBrowser 
EX.
You can also copy/move two or more files and folders in a single step.

2 From the Tree View of ZoomBrowser EX, select the library or folder which contains 
the newly added image data.

3 Right-click with the mouse to open the pop-up menu, and select Refresh Folder.
This refreshes the content information (database) of the selected library or folder, 
by registering the new image data added through the Windows Explorer.
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Printing from PhotoRecord

This chapter describes how to print your photos using a variety of photo-printing features of the 
PhotoRecord utility. When using ZoomBrowser EX, select the photos (or folder) you want to print 
from either the Browser Display Area or the Camera Window, and then click the PRINT button and 
select Layout from the submenu. The PhotoRecord utility will automatically start to provide the 
following functions: 

• Printing a Photo Index (Index Printing)
• Custom Layout Printing (Artwork/Layout Album)
• Printing in a Specified Photo Size (Fixed Photo Size Printing)
• Printing in the Borderless Printing Mode (Tiled Photo)
• Printing on Canon Perforated Paper
• About Canon Perforated Paper
• Starting Printing
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Printing a Photo Index (Index Printing)

One way to print a photo index is to activate PhotoRecord, select the Layout mode to set the photo 
size, background, and other properties, and then output the print data. The other and easier way is 
to use the PRINT button in the ZoomBrowser EX window. One click on the button starts printing 
directly from ZoomBrowser EX.

ZoomBrowser EX prints all the selected photos in an 
automated layout. 
If you also want to print the file names and/or dates of the 
photos, open the Preferences dialog box and specify the 
captions.
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An Easy Way to Print an Index

You can print a photo index directly from ZoomBrowser EX, just by clicking the PRINT button.

Steps

1 Select the photos or folders of which you want to make an index from the Browser 
Display Area of ZoomBrowser EX, and then click the PRINT button to open the 
pop-up submenu.

Note ➤ If you want to select two or more photos, click the photo images while pressing the 
Ctrl key.
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2 Select Index from the PRINT button pop-up submenu.
The Index Print Settings dialog box appears.

The number of pages varies depending on 
the number of photos, paper settings, and 
the thumbnail size.
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3 Specify the Thumbnail size, Media Type, Paper Size, Orientation, and Print 
quality options.
You can select a thumbnail size from Small, Medium, and Large.
If you want to add a background image, click the Set Page Art button to open the 
Change Page Artwork dialog box. Specify an image to go with your pages.

4 Click the OK button.
The printer starts printing.

(Large) (Small)(Medium)
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Previewing the Layout before Printing an Index

You can preview the page layout on the screen before printing a photo Index.

Steps

1 Select the photos of which you want to make an index from the Browser Display 
Area of ZoomBrowser EX. Click the PRINT button and select Layout from the 
PRINT button pop-up submenu.
PhotoRecord starts and the PhotoRecord Print Modes dialog box opens, ready to 
start the Print Modes wizard.

2 Select the desired printer. Select Artwork/Layout album from the Print Mode 
options.
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3 Click the Next button to proceed to the next step.

4 Specify Media Type, Paper Size, and Orientation.
The Preview area shows the print image in relation to the current settings. 
Clicking the Set Page Margins button allows you to widen or narrow the area for 
printing the image data.

5 Click the Next button to proceed to the next step.
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6 Select Index layout.

7 Select the thumbnail size from the Photo size drop-down list.
You can select from Small, Medium, and Large.

8 Click the Finish button.
The PhotoRecord window opens. It automatically positions the selected photos to 
fit the current paper settings.
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Artwork Options
In the Artwork/Layout album mode, you can clip or resize your photos, arrange 
them in a desired layout, add text, and add photo frames and background.
Starting Printing
Click the PRINT button to start printing.

 
The Album Control Panel in the PhotoRecord window 
contains the controls shown below. These controls 
enable you to access various artwork options.



Custom Layout Printing (Artwork/Layout Album) 97

Custom Layout Printing (Artwork/Layout Album)

The Artwork/Layout album option allows you to arrange your photos in a desired layout and apply 
a variety of artwork including clipping, resizing, rotation, text insertion, and ornamentation with photo 
frames and background. See Artwork for details on the artwork features.

 
You can add a page
title.
See Inserting a Page Title.

 
You can add photo 
captions.
See Adding and 
Positioning Text.

 
You can add photo 
frames and background 
to make an ornamented 
album.
See Page Art.

 
You can clip or trim a 
photo.
See Clipping a Photo.

 
You can move, resize, or 
rotate the photos for 
graphic effects.
See Changing Layout.
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Setting the Print Mode

Specify the size and position of each photo and arrange the photos in a desired layout.

Steps

1 Select a photo or photos to print from the Browser Display Area, click the PRINT 
button, and select Layout from the PRINT button pop-up submenu.
PhotoRecord starts and the PhotoRecord Print Modes window opens, ready to 
start the Print Modes wizard.
The options in this window vary depending on the printer type.

2 Select the desired printer from the Printer list and select Artwork/Layout album 
from the Print Mode options.
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3 Click the Next button to proceed to the next step.

4 Specify Media Type, Paper Size, and Orientation.
The Preview area shows the print image in relation to the current settings. 
Clicking the Set Page Margins button allows you to widen or narrow the area for 
printing the album page.
You can enable the Borderless Printing function by selecting the Use Canon 
Borderless Printing check box.

Note ➤ The Use Canon Borderless Printing check box is available only when you are 
using a printer that supports the feature of borderless printing.



Custom Layout Printing (Artwork/Layout Album) 100

5 Click the Next button to proceed to the next step.

6 Specify how the photos should be arranged on the album page.
Select Automatic layout to have the photos automatically arranged by 
PhotoRecord.
Select Index layout to use the Index Printing feature.
Select Manual layout to position the photos temporarily so that you may freely 
rearrange them.
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7 Click the Finish button.
The PhotoRecord window opens to display the selected photos in the new layout. 
They are arranged in the most suitable way for your paper settings.

Artwork Options
In the Artwork/Layout album mode, you can clip or resize your photos, arrange 
them in a desired layout, add text, and add photo frames and background.
Starting Printing
Click the PRINT button to start printing.

 
The Album Control Panel in the PhotoRecord window 
contains the controls shown below. These controls enable 
you to access various artwork options.
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Printing in a Specified Photo Size 
(Fixed Photo Size Printing)

The Fixed photo size printing option allows you to print all the selected photos in a specified photo 
size. 
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Setting the Print Mode

Specify the photo size you want to print your photos. PhotoRecord automatically arrange the photos 
to match the setting.

Steps

1 Select a photo or photos to print from the Browser Display Area, click the PRINT 
button, and select Layout from the PRINT button pop-up submenu.
PhotoRecord starts and the PhotoRecord Print Modes dialog box opens, ready to 
start The Print Modes wizard.

2 Select the desired printer. Select Fixed photo size printing from the Print Mode 
options.
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3 Click the Next button to proceed to the next step.

4 Specify Media Type, Paper Size, and Orientation.
The Preview area shows the print image in relation to the paper. 

5 Click the Next button to proceed to the next step.
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6 Specify the Photo Size.
If you select the Automatic clipping check box, PhotoRecord automatically 
resizes and clips the photos to fit the specified photo size.
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7 Click the Finish button.
The PhotoRecord window opens. It automatically positions the selected photos to 
fit the current paper settings.

Artwork Options
In the Fixed photo size printing mode, you can only add text, clip photos, and 
rotate photos (with some limitations). You cannot resize photos, change layout, or 
add photo frames or background.
Starting Printing
Click the PRINT button to start printing.

 The Album Control Panel in the PhotoRecord window contains 
the controls shown below.
Note that available artwork options are limited in the Fixed photo 
size printing mode.
However, you can specify the print quality and number of copies 
to print.
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Printing in the Borderless Printing Mode (Tiled Photo)

The Borderless printing (Tiled photo) option allows you to print photos with no margins left 
around the photos. This mode requires a printer that supports borderless printing.
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Setting the Print Mode

Select borderless printing and specify paper settings with the number of photos to be arranged as 
tiles on a single page.

Steps

1 Select a photo or photos to print from the Browser Display Area. Click the PRINT 
button and select Layout from the PRINT button pop-up submenu.
PhotoRecord starts and the PhotoRecord Print Modes dialog box opens, ready to 
start The Print Modes wizard.

2 Select the desired printer. Select Borderless printing (Tiled photo) from the Print 
Mode options.
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3 Click the Next button to proceed to the next step.

4 Specify Media Type, Paper Size, and Orientation.
The Preview area shows the print image in relation to the current paper setting. 
Clicking the Set Page Margins button allows you to widen or narrow the area for 
printing the image data.
You can enable the borderless printing feature by selecting the Use Canon 
Borderless Printing check box.

Note ➤ The Use Canon Borderless Printing check box is available only when you are 
using a printer that supports feature of borderless printing.
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5 Click the Next button to proceed to the next step.

6 Specify the number of photo tiles you want to place on a single page.
Select 1 (1 row) when printing a single photo with no margins.
If you select the Automatic clipping check box, PhotoRecord automatically 
resizes and clips the photos to fit the specified photo size.
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7 Click the Finish button.
The PhotoRecord window opens. It automatically positions the selected photos to 
fit the current paper settings.

Artwork Options
In the Borderless printing (Tiled photo) mode, you can only add text, clip photos, 
and rotate photos (with some limitations). You cannot resize photos, change layout, 
or add photo frames or background.
Starting Printing
Click the PRINT button to start printing.

The Album Control Panel in the PhotoRecord window contains the 
controls shown below.
Note that available artwork options are limited in the Borderless 
printing (Tiled photo) mode.
However, you can specify the print quality and number of copies to print.
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Printing on Canon Perforated Paper

You can easily print with Canon Perforated Paper in a just-fit layout.
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Setting the Print Mode

You can print your photos on Canon perforated paper by simply selecting the paper type. 
PhotoRecord automatically aligns the photos with the perforations.

Steps

1 Select a photo or photos to print from the Browser Display Area. Click the PRINT 
button and select Layout from the PRINT button pop-up submenu.
The PhotoRecord starts and the PhotoRecord Print Modes dialog box opens, 
ready to start The Print Modes wizard.

2 Select the desired printer. Select Canon perforated paper printing from the Print 
Mode options.
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3 Click the Next button to proceed to the next step.

4 Specify the type of Canon perforated paper.
The Preview area shows how the photos are arranged under the current settings. 
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5 Click the Finish button.
The PhotoRecord window opens. It automatically positions the selected photos to 
fit the current paper settings.

Artwork Options
In the Canon perforated paper printing mode, you can only add text, clip photos, 
and rotate photos (with some limitations). You cannot resize photos, change layout, 
or add photo frames or background.
Starting Printing
Click the PRINT button to start printing.

The Album Control Panel in the PhotoRecord window contains the controls 
shown below.
Note that available artwork options are limited in the Canon perforated 
paper printing mode.
However, you can specify the print quality and number of copies to print.
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About Canon Perforated Paper

This section briefly describes Canon perforated paper.
The photos printed on Canon perforated paper can easily be cut apart along the perforated lines. 
This relatively thick, high glossy paper lets you print photo-quality images without blank portions 
around them. Types of Canon perforated paper are:

Glossy Photo Card <FM-101>
Photo Paper Pro <PC-101 S>
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Starting Printing

When you have finished all necessary steps for the page layout, click the PRINT button to start 
printing. 
The Print dialog box appears.

Click the Print button to start printing.

Selecting the Use Canon Vivid Photo 
check box enables the Vivid Photo Printing 
feature. It will reproduce blues and greens 
in compensated vivid colors.
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Artwork

You can apply artwork to your photos placed in the PhotoRecord window. You can clip photos, add 
a background and photo frames, change the layout, and insert text.

• Page Art
• Changing Layout
• Adding Text
• Clipping a Photo
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Page Art
You can add a frame to each photo or a 
background to the album page.

Clipping
You can specify an area of a photo image to clip 
and print. This does not affect the original photo. 
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Note ➤ Some of the above edit functions may be only partly available, depending on the 
Print Mode option you have selected.

Adding text

You can insert text anywhere on your page. Use this feature 
to add photo captions, page titles, and so on.

Changing layout

You can move photos anywhere on your page. 
You can enlarge or reduce the photos. 
You can also rotate or remove the photos. 
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Page Art

When you are working in the Artwork/Layout album mode, you can specify a background for the 
page currently displayed in the PhotoRecord window, or select frames to ornament the photos.
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Adding a Page Background

You can specify a background to print with your pages by a simple operation.

Steps

1 Click the PAGE ART button.
The Change Page Artwork dialog box appears.
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2 Select an artwork pattern which you want to use as a page background.
To select a pattern, select a sample panel and click on the desired sample pattern.

Samples are grouped under several tabs 
according to their types. Click a tab to 
select a sample panel, and select the 
pattern you want to use.

These buttons allow you to scroll the tabs.

A wide variety of background patterns 
are available.

Click on the desired sample pattern to select it.
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3 Select a color.

Click the Choose button to display the color selection window and select a new 
color. Click the Default button to bring back the default color. The Coloring 
function is not available for Borderless Wood, Borderless Rocks, and some other 
groups of background patterns.

4 Specify to which page or pages you want to apply the selected background.
Select All pages to apply the selected background to all the pages in the 
PhotoRecord window.
Select This page only to apply the selected background only to the current page.
Select Pages: and enter page numbers in the text box if you want to apply the 
selected background to specified pages.

5 Click the OK button.
The Change Page Artwork dialog box closes and the selected background is 
reflected in the PhotoRecord window.
If you click the Apply button, the selected background is reflected in the 
PhotoRecord window without closing the Change Page Artwork dialog box.

To select a color, click the corresponding 
preset button. See how the color is 
reflected in the preview area.

This box shows the selected color.

Preview area
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Adding a Photo Frame

You can specify a frame to ornament a photo by a simple operation.

1 Select a photo and click the  (option button) to open a pop-up menu, and then 
select Change Photo Frame.
The Change Photo Frame dialog box appears.

2 Select a frame pattern which you want to use as a photo frame.

Option button
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To select a pattern, select a sample panel and click on the desired sample pattern.
Samples are grouped under several tabs 
according to their types. Click a tab to 
select a sample panel, and select the 
pattern you want to use.

Click on the desired sample pattern to 
select it.

A wide variety of frame patterns are 
available.
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3 Select a color.

Click the Choose button to display the color selection window and select a new 
color. Click the Default button to bring back the default color. The Coloring 
function is not available for Wood, Tacks, and some other groups of frame 
patterns.

4 Specify to which photos or pages you want to apply the selected frame.
Select All photos to apply the selected frame to all the photos in the PhotoRecord 
window.
Select Current page only to apply the selected frame only to the photos in the 
current page.
Select Current photo only to apply the selected frame only to the photo selected 
in the PhotoRecord window.

5 Click the OK button.
The Change Photo Frame dialog box closes and the selected frame is reflected in 
the PhotoRecord window.
If you click the Apply button, the selected frame is reflected in the PhotoRecord 
window without closing the Change Photo Frame dialog box.

To select a color, click the corresponding 
preset button. See how the color is 
reflected in the preview area.

This box shows the selected color.

Preview area.
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Changing Layout

When you are working in the Artwork/Layout album mode, you can re-position the photos in the 
PhotoRecord window to make up a new layout.
You can rotate or resize the photos. You can also remove the photos from the layout.

The clipping and rotating functions are also available in the other print modes, but each with some 
limitations.
Processing of the photos by resizing, rotating, clipping, or removing them does not affect the original 
photo image data. The result is reflected only on the print pages.



Changing Layout 129

Re-positioning the Photos

You can re-position (move) the photos within the PhotoRecord window.
If you have selected Layout from the PRINT button pop-up submenu in the Artwork/Layout album 
mode, you can freely move the photos to a new position by drag-and-dropping in the window.

Steps

1 Set the LAYOUT slide switch at MANUAL. 

Note ➤ If the switch is set at AUTO, dragging a photo moves not only the selected photo 
but also all the other photos.
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2 Select and mouse-drag a photo wherever you want to place it.

Note ➤ When the current print mode is not Artwork/Layout album (including Index 
layout), the basic layout cannot be modified. You can only change the order of the 
photos by mouse-dragging operation.



Changing Layout 131

Resizing the Photos

When you are working in the Artwork/Layout album mode, you can enlarge or reduce the photos 
using the mouse-dragging operation. You cannot resize the photos when working in other print 
modes.

Steps

1 Set the LAYOUT slide switch at MANUAL. 

Note ➤ If the switch is set at AUTO, dragging a photo resizes not only the selected photo 
but also the other photos.
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2 Select the photo you want to resize. Ensure that the photo is in the Resize mode.
A red arrow appears on each of the four borders.

3 Put the mouse cursor over any of the red arrows and drag until the image is 
enlarged or reduced to the desired size.

Resize mode and Rotate mode

If you see a red arrow on each of the four borders of a selected photo, 
the photo is in the Resize mode.
If you see a blue arrow at each of the four corners of a selected photo, 
the photo is in the Rotate mode.

Resize mode Rotate mode

Click here to 
select the Rotate 
mode.

Click here to 
select the Resize 
mode.

Put the mouse cursor here and drag.



Changing Layout 133

Rotating the Photos

When you are working in the Artwork/Layout album mode, you can rotate the photos to any 
desired angles using the mouse-dragging operation.
You can only specify a 180-degree rotation when working in the other print modes.

Steps

1 Set the LAYOUT slide switch at MANUAL. 

Note ➤ If the switch is set at AUTO, dragging a photo rotates not only the selected photo 
but also all the other photos.
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2 Select the photo you want to rotate. Ensure that the photo is in the Rotate mode.
A blue arrow appears at each of the four corners.

3 Put the mouse cursor over any of the blue arrows and drag until the image rotates 
to the desired angle.

Resize mode and Rotate mode

If you see a red arrow on each of the four borders of a selected photo, 
the photo is in the Resize mode.
If you see a blue arrow at each of the four corners of a selected photo, 
the photo is in the Rotate mode.

Resize mode Rotate mode

Click here to 
select the Rotate 
mode.

Click here to 
select the Resize 
mode.

Put the mouse cursor here and drag.
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Removing a Photo

You can remove (clear) a photo from the layout in the PhotoRecord window.
Here removing a photo means just excluding it from the print page. It does not mean deleting the 
actual image file from your computer.

Steps

1 Click the option button attached to the photo you want to remove. A pop-up menu 
appears.

2 From the menu, select Cut (Remove) Photo.
The selected photo is removed.



Adding Text 136

Adding Text

You can add text to your pages in the PhotoRecord window.  Use this function to insert photo 
captions, page titles, and so on.
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Adding and Positioning Text

You can type text in the Edit Text box to put it on your pages in the PhotoRecord window.

Steps

1 Click the option button on the left side of the current page.

Option button
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2 The option menu appears. Select Add Text from the menu.
The Edit Text dialog box appears.

There is an alternative to display the Edit Text dialog box. Ensure that no photo is 
selected, then right-click within the PhotoRecord window. From the pop-up menu, 
select Add Text.
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3 Type in a text string.

Specify the font. Specify the font size.

Specify the font style.
Four font style options are 
available: 
bold, italic, underline, and 
font color (from left to right).

Specify the text alignment.

This area allows you to check the result of font name, font style, font 
size, and alignment selection before they are reflected in the main 
window (from left to right).
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4 Click the OK button.
The typed text will appear on the current page.

You can change the ornament of each text block. You can 
also move a text block wherever you want to place it, by 
dragging it with the mouse.
You can always re-edit your text later, by double-clicking the 
text block to re-open the Edit Text dialog box.
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Applying Artwork to Text

You can specify ornament for each of your text.

Steps

1 Select a text block and click the option button.

Option button
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2 The option menu appears. Select Change Frame from the menu.
The Change Text Frame dialog box appears.
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3 Select an artwork pattern you want to apply to the text block.
To select an ornament pattern, select a sample panel and click on the desired 
sample pattern in the panel.

Samples are grouped under several tabs 
according to their types. Click a tab to 
select a sample panel and select the 
desired pattern.

These buttons allow you to scroll the 
tabs.

A wide variety of ornament patterns are 
available.

Click on the sample pattern to select it.
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4 Select a color.

Click the Choose button to display the color selection window and select a new 
color. Click the Default button to bring back the default color.

5 Specify to which text blocks you want to apply the selected ornament pattern.
Select All text blocks to apply the selected ornament pattern to all the text blocks 
in the PhotoRecord window.
Select Text blocks on current page to apply the selected ornament pattern only to 
the text blocks on the current page.
Select This text block only to apply the selected ornament pattern only to the text 
block currently selected.

6 Click the OK button.
The Change Text Frame dialog box closes and the selected ornament pattern is 
reflected in the PhotoRecord window.
If you click the Apply button, the selected ornament pattern is reflected in the 
PhotoRecord window without closing the Change Text Frame dialog box.

To select a color, click the corresponding 
preset button. See how the color is 
reflected in the preview area.

This box shows the selected color.

Preview area.
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Adding a Caption to a Photo

When you are working in the Artwork/Layout album mode, the entered caption is displayed just 
below the selected photo. In the other print modes, the entered caption is displayed inside one of 
the corners of the selected photo. You can move the caption to another corner of the photo.
There is an automated way of printing the photo data file names and/or the date and time of 
photographing as a caption. Specify captions from the Preferences dialog box of the ZoomBrowser 
EX.

Steps

1 Select a photo and click the option button.

Option button
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2 A pop-up menu appears. Select Edit Caption from the menu to display the Edit 
Text dialog box.

3 Type in a text string.

4 Click the OK button.
The caption appears on the current page.

Specify the font. Specify the font size.

Specify the font style.
Four font style options are 
available: 
bold, italic, underline, and 
font color (from left to right).

Specify the text alignment.

This area allows you to check the result of font name, font style, font size, and 
alignment settings before they are reflected in the main window (from left to right).
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Inserting a Page Title

A page title is always inserted at the top of the printable area. You can align the text in the text block 
by selecting an alignment option (align left, center text or align right). The text block itself does not 
move from its fixed position.

Steps

1 Click the option button on the left side of the current page.

Option button
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2 A pop-up menu appears. Select Edit Title from the menu to display the Edit Text 
dialog box.
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3 Type in a text string.

4 Click the OK button.
The title is displayed at the top of the printable area. You can align the text in the 
text block using an alignment option (align left, center text, or align right). 
You can apply artwork (ornament) to the text.

Specify the font. Specify the font size.

Specify the font style.
Four font style options are 
available: 
bold, italic, underline, and 
font color (from left to right).

Specify the text alignment.

This area allows you to check the result of font name, font 
style, font size, and alignment settings before they are 
reflected in the main window (from left to right).
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Clipping a Photo

You can clip your photos displayed in the PhotoRecord window.
The photo-clipping feature allows you to print part of a photo image. It does not affect the original 
photo image file.

Steps

1 In the PhotoRecord window, double-click the photo you want to clip.
The Photo Viewer window appears.

Photo Viewer window

As an alternative, select the photo first, right-click to 
open a pop-up menu, and then select Clip/Correct 
Photo from the menu.

Photo Control Panel
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2 On the Photo Control Panel, click the CLIP button to enter the Clipping mode. 
Drag the clipping cursor over the Photo Viewer window until the part of the photo 
image you want to print is enclosed in an outline.
To cancel the selection, click the CLIP button again.

3 Click the CLOSE button on the Photo Control Panel.

Note ➤ The size of the clipped area depends upon the Artwork/Layout album mode 
option you selected. When the selected mode is Fixed photo size printing, 
Borderless printing (Tiled photo), or Canon perforated paper printing, the 
clipped area is fixed in its height-width ratio.

Photo area to be clipped

Clipped photo



152

Printing with Easy-PhotoPrint

Easy-PhotoPrint is an application program that allows you to make high-quality prints from the 
images you recorded with your digital camera in a quick and easy fashion. You can print a selected 
image on 4 x 6 inch (approx. 10 x 15 cm) paper or a photo index that contains thumbnails. 
Easy-PhotoPrint supports Exif Print (Exif 2.2).  
The image captured with an Exif Print-compliant digital camera can be optimized using data, such 
as camera settings (white balance, exposure time) etc, stored at the time of shooting, yielding 
extremely high-quality prints.

Note ➤ Easy-PhotoPrint can handle only JPEG files (file name extension: .jpg and .jpeg). 
Other files are not displayed on the screen.

• Starting Easy-PhotoPrint
• Selecting Images
• Selecting Paper
• Layout Printing
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Starting Easy-PhotoPrint

You can start Easy-PhotoPrint by either of the following two methods:

Starting by Pressing the Start Button 

1 Click Start and select Programs - Canon Utilities - Easy-PhotoPrint - 
Easy-PhotoPrint.

Note ➤ For Windows XP, click Start and select All Programs - Canon Utilities - 
Easy-PhotoPrint - Easy-PhotoPrint.

Starting from ZoomBrowser EX

1 Select an image with ZoomBrowser EX.

2 Select Print from the Files menu of ZoomBrowser, and then select Easy-
PhotoPrint.

Note ➤ • Click the Print button to select Easy-PhotoPrint.
• Easy-PhotoPrint can be accessed from ZoomBrowser EX Ver. 3.3 or later.
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Selecting Images

1 Select the folder that contains the image you want to print from the folder window 
on the 1. Image Selection sheet. 

Note ➤ The folder window is not displayed when Easy-PhotoPrint is started from 
ZoomBrowser EX. Only the images selected in Zoom Browser are displayed.

Guidance

Folder Window
The folder window lists folders contained in your computer. Selecting a folder 
displays the image files contained there as thumbnails. The folder window is not 
displayed when Easy-PhotoPrint is started from ZoomBrowser EX.

Thumbnail
Reduced images contained in the 
folder selected from the folder window 
are displayed.
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2 Click  on the thumbnail of the image you want to print and specify the number 
of copies.

The number of copies increases by 1 each time you click  and it decreases by 
1 each time you click . Left-clicking the button will reset the number of copies 
to 0. The specified number of copies is displayed between the buttons.
To view details of the selected image, click the image and then click Zoom in.... 
The enlarged image will be displayed in a separate window. You can also zoom in 
on the image by double-clicking it. 

Note ➤ • A maximum of 99 copies can be specified for each image. A maximum of 
10000 copies can be specified for the selected images. These numbers of 
copies become smaller when the free spaces in the memory and hard disk 
are small.

• Thumbnails can be displayed on the 1. Image Selection sheet in three sizes. 
Select Thumbnail Size from the View menu on the 1. Image Selection sheet and 
then select Small, Medium, or Large to specify a thumbnail size.

The number of copies increases.
The specified number of copies is displayed.
The number of copies decreases.
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Selecting Paper

You can select the printer and paper you want to use for printing.
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Steps

1 Select the printer you use from Printer on the 2. Paper Selection sheet.

2 Select the size of the paper you use from Paper Size.
Only the sizes of paper that can be used for the selected printer are displayed.

3 Select the type of the paper you use from Media Type.
Only the types of paper available in the selected size are displayed.

Note ➤ • Checking the Vivid Photo check box, you can print the selected image with more 
vivid colors.

• If you have selected Paper Plus Glossy from Media Type, it will take much time to 
print on other types of paper. In such a case, select a paper type again in the 
following manner:
(1) Select the type of the media you use for printing from Media Type.
(2) Close Easy-PhotoPrint.
(3) Start Easy-PhotoPrint again, select a number of copies, and open the 2. Paper 

Selection sheet to check the paper type selected now. 
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Layout Printing

You can select a desired layout and print an image in the selected layout. 

Layout
Select a layout from the Layout list box. The image(s) is displayed in the 
selected layout in the preview window. 
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The procedure for layout printing is as follows:

Steps

1 Ensure that the printer is turned on and paper is loaded in the printer.

2 Select Layout.
Layout types displayed here vary depending on the selected printer, paper size, 
and media type.

Note ➤ Rotate and/or trim the image as required.

3 Click Print.
Printing starts.
When Easy-PhotoPrint is started from ZoomBrowser EX, Easy-PhotoPrint is closed 
automatically at the end of printing and the ZoomBrowser EX screen reappear.
You can cancel printing within five seconds pass after Print is clicked. To cancel 
printing, click Cancel in the displayed dialog box.
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How to Use Online Help

Some of the photo applications provide you with Online Help information about functions and 
operations. It contains a brief description of operational steps that you can read on the screen while 
operating the program.
This chapter informs you how to use the Online Help of each application.
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Online Help of ZoomBrowser EX

Two sets of Online Help are accessible from the Help menu of ZoomBrowser EX: What is 
ZoomBrowser EX? and Show Quick Tips.

What is ZoomBrowser EX?
Look up explanations about major functions and operations of ZoomBrowser EX.
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Show Quick Tips
You can choose whether or not to display Quick Tips at an appropriate time while working with 
ZoomBrowser EX. Relevant topics are featured when using some of the major functions.

How to Use

1 Open the Help menu, and select Show Quick Tips.

2 From the submenu, select (check mark) to display Tips you need. Quick Tips will 
appear as soon as you try the check marked feature. Closing the Tips window 
unchecks that feature and Tips will stop appearing.
You can either check mark all or uncheck all by selecting the Tick All or Untick All 
option command.
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Online PhotoRecord Help

Two sets of Online Helps are accessible from the Help menu of PhotoRecord: Contents & Index and 
What’s This?

How to Use
From the Help menu, click Contents & Index. You can look up explanations about the major 
functions and operations of PhotoRecord.
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What’s This?
To understand what a button or an area means, select What’s This? from the Help menu. The 
cursor turns into a ? mark. Point the desired object to display a brief explanation.
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Index

Index

A
Adding Sound to Images 52
Adding text 120
Adjusting Image Colors 45
Album Control Panel 96, 101, 106, 111, 115
Applying artwork 12
Artwork 118, 141
artwork 6
Automation Wizard 61, 65
Automation wizard 10

B
Borderless Printing 7
Borderless Printing Mode 107
Browser Display 18
Browser Display Area 21, 26, 37, 42, 47, 55, 98

C
Camera Window 10, 69, 71, 73
Canon Utilities 13
captions 145
Changing Layout 128
Changing layout 120
Changing Location of Image Files 37
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Index

Clipping 119
Clipping a Photo 150
CONNECT CAMERA button 76
Control Panel 21, 22, 25
Creating Panoramic Photo Using PhotoStitch 18
Creating Panoramic photo Using PhotoStitch 18
Cropping Images 44

D
DELETE button 22, 38, 78
Deleting Images 38
digital camera 9
DOWNLOAD button 78

E
Editing Images from Other Application Programs 58
Editor Application 58
E-mail 55
Exif Print 4

F
Fixed Photo Size 102
fixed photo size printing 7
font name 139
font size 139

H
Headers 147
HELP button 83
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Index

I
Image Database 27
IMAGE INFO button 81
Image Library One 28
IMPORT IMAGES button 22
Importing Images 60
Importing images 10
Importing Images by Drag-and-Drop Operation 86
Importing Images from a TWAIN Device 84
Importing Images from the Camera Window 69
Importing Images with the Automation Wizard 60, 61

L
layout 6

M
Magnifier 26
memory card 10
Merging Panoramic Images by PhotoStitch 18

O
Online Help 160
Opening Image Files from Other Applications 58

P
Page Art 119, 121
Page Art Options 96, 101, 106, 111, 115
Page Background 122
page header 147
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Index

Perforated Paper 112, 113
perforated paper 12, 116
Photo Control Panel 151
Photo Frame 125
photo Index 93
photo index 6, 89
Photo Size 102
Photo size 105
photo size 7
photo-clipping 150
PhotoRecord window 95, 101, 129, 150
PhotoStitch 18
Previewing the Layout before Printing an Index 93
Print an Index 90
PRINT button 22, 79
Print Mode 103, 108, 113
Printing from PhotoRecord 88
Printing the Photo Index 89
Processing 3D Images by 3D-PhotoPrint 19
Processing Images for Sending by E-mail 55
Processing Images from Image Viewer 43

R
REFRESH button 22
Register Image Folder dialog box 33
Removing a Photo 135
Re-positioning the Photos 129
Resizing the Photos 131
ROTATE button 79
Rotating the Photos 133
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Index

S
Saving Images after Processing 46
scanner 9
scanning 9
Scroll Mode 22, 25
SELECT button 77
Selecting Automatic Image Downloading 62
Selecting layout 11
Set Logical Volume Name dialog box 33
Setting the Print Modes 98
Shooting 9
SHOW PROPERTIES button 22
Slide Show 47
Slide Show Control Buttons 50
SLIDE/DPOF button 82

T
Text block 141
Text Blocks 137
Thumbnails 21, 74
thumbnails 37
tiled photo 7
Time Tunnel 51
Tool switching buttons 23
Tree View 21, 37, 71
TWAIN 84

U
UPLOAD button 80
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Index

V
VIEW IMAGE button 22
View Mode buttons 22

Z
Zoom Mode 22, 24
ZoomBrowser EX 20
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